Chapter 100

Tests for One Proportion

Introduction

The One-Sample Proportion Test is used to assess whether a population proportion \((P1)\) is significantly different from a hypothesized value \((P0)\). This is called the hypothesis of inequality. The hypotheses may be stated in terms of the proportions, their difference, their ratio, or their odds ratio, but all four hypotheses result in the same test statistics.

For example, suppose that the current treatment for a disease cures 62% of all cases. A new treatment method has been proposed and studied. In a sample of 80 subjects with the disease that were treated with the new method, 63 were cured. Do the results of this study support the claim that the new method has a higher response rate than the existing method?

This procedure calculates sample size and statistical power for testing a single proportion using either the exact test or other approximate z-tests. Exact test results are based on calculations using the binomial (and hypergeometric) distributions. Because the analysis of several different test statistics is available, their statistical power may be compared to find the most appropriate test for a given situation.

This procedure has the capability for computing power using both the normal approximation and binomial enumeration for all tests. Some sample size programs use only the normal approximation to the binomial distribution for power and sample size estimates. The normal approximation is accurate for large sample sizes and for proportions between 0.2 and 0.8, roughly. When the sample sizes are small or the proportions are extreme (i.e. less than 0.2 or greater than 0.8) the binomial calculations are much more accurate.

Binomial Model

A binomial variable should exhibit the following four properties:

1. The variable is binary --- it can take on one of two possible values.
2. The variable is observed a known number of times. Each observation or replication is called a Bernoulli trial. The number of replications is \(n\). The number of times that the outcome of interest is observed is \(r\). Thus \(r\) takes on the possible values 0, 1, 2, ..., \(n\).
3. The probability, \(P\), that the outcome of interest occurs is constant for each trial.
4. The trials are independent. The outcome of one trial does not influence the outcome of the any other trial.

A binomial probability is calculated using the formula

\[
b(r; n, P) = \binom{n}{r} P^r (1 - P)^{n-r}
\]
The Hypergeometric Model

When samples are taken without replacement from a population of known size, \( N \), the hypergeometric distribution should be used in place of the binomial distribution. The properties of a variable that is distributed according to the hypergeometric distribution are

1. The variable is binary--it can take on one of two possible values.
2. The variable is observed a known number of times. Each observation or replication is called a Bernoulli trial. The number of replications is \( n \). The number of times that the outcome of interest is observed is \( r \). Thus \( r \) takes on the possible values 0, 1, 2, ..., \( n \).
3. The total number of items is \( N \). The proportion of items with the characteristic of interest is \( P \).

The hypergeometric probability of obtaining exactly \( r \) of \( n \) items with the characteristic of interest is calculated using

\[
h(r; N, n, P) = \frac{\binom{NP}{r} \binom{N-NP}{n-r}}{\binom{N}{n}}
\]

Note that the quantity \( NP \) is rounded to the nearest integer.

Hypothesis Testing

Parameterizations of the Proportions

There are several ways to specify the proportions under the null and the alternative hypotheses. The most direct is to simply give values for \( P_0 \) and \( P_1 \). However, it is often more meaningful to specify \( P_0 \) and then specify the alternative as the difference, the ratio, or the odds ratio. The value of \( P_1 \) is calculated from these values.

Mathematically, these alternative parameterizations are

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Computation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Difference</td>
<td>( \delta = P_1 - P_0 )</td>
</tr>
<tr>
<td>Ratio</td>
<td>( \phi = \frac{P_1}{P_0} )</td>
</tr>
<tr>
<td>Odds Ratio</td>
<td>( \psi = \frac{O_1}{O_0} = \frac{P_1/(1-P_1)}{P_0/(1-P_0)} )</td>
</tr>
</tbody>
</table>
Difference
The (risk) difference, $\delta = P_1 - P_0$, is perhaps the most direct method of comparison between the two proportions. This parameter is easy to interpret and communicate. It gives the absolute impact of the treatment. However, there are subtle difficulties that can arise with its interpretation.

One interpretation difficulty occurs when the event of interest is rare. If a difference of 0.001 is reported for an event with a baseline probability of 0.40, we would dismiss this as being trivial. That is, there is usually little interest in a treatment that decreases the probability from 0.400 to 0.399. However, if the baseline probability of a disease is 0.002, a 0.001 decrease in the disease probability would represent a reduction of 50%. The interpretation depends on the baseline probability of the event.

Ratio
The (risk) ratio, $\phi = P_1 / P_0$, gives the relative change in the probability of the outcome under each of the hypothesized values. This parameter is direct and easy to interpret. To compare the ratio with the difference, examine the case where $P_0 = 0.1437$ and $P_1 = 0.0793$. One should consider which number is more enlightening, the difference of -0.0644, or the ratio of 55.18%. In many cases, the ratio communicates the change in proportion in a manner that is more appropriate than the difference.

Odds Ratio
Chances are usually communicated as long-term proportions or probabilities. In betting, chances are often given as odds. For example, the odds of a horse winning a race might be set at 10-to-1 or 3-to-2. Odds can easily be translated into probability. An odds of 3-to-2 means that the event is expected to occur three out of five times. That is, an odds of 3-to-2 (1.5) translates to a probability of winning of 0.60.

The odds of an event are calculated by dividing the event risk by the non-event risk. Thus the odds are

$$O_1 = \frac{P_1}{1 - P_1} \quad \text{and} \quad O_0 = \frac{P_0}{1 - P_0}$$

For example, if $P_1$ is 0.60, the odds are 0.60/0.4 = 1.5. Rather than represent the odds as a decimal amount, it is re-scaled into whole numbers. Thus, instead of saying the odds are 1.5-to-1, we say they are 3-to-2.

Thus, another way to compare proportions is to compute the ratio of their odds. The odds ratio of two proportions is

$$\psi = \frac{O_1}{O_0} = \frac{P_1/(1-P_1)}{P_0/(1-P_0)}$$

Test Statistics
Many different test statistics have been proposed for testing a single proportion. Most of these were proposed before computers or hand calculators were widely available. Although these legacy methods are still presented in textbooks, their power and accuracy should be compared against modern exact methods before they are adopted for serious research. To make this comparison easy, the power and significance of several tests of a single proportion are available in this procedure.

Exact Test
The test statistic is $r$, the number of successes in $n$ trials. This test should be the standard against which other test statistics are judged. The significance level and power are computed by enumerating the possible values of $r$, computing the probability of each value, and then computing the corresponding value of the test statistic. Hence the values that are reported in the output for these tests are exact, not approximate.
**Z-Tests**

Several $z$ statistics have been proposed that use the central limit theorem. This theorem states that for large sample sizes, the distribution of the $z$ statistic is approximately normal. All of these tests take the following form:

$$ z = \frac{p - P_0}{s} $$

Although these $z$ tests were developed because the distribution of $z$ is approximately normal in large samples, the actual significance level and power can be computed exactly using the binomial distribution.

We include four $z$ tests which are based on two methods for computing $s$ and whether a continuity correction is applied.

**Z-Test using $S(P_0)$**

This test statistic uses the value of $P_0$ to compute $s$.

$$ z_1 = \frac{p - P_0}{\sqrt{P_0(1 - P_0) / n}} $$

**Z-Test using $S(P_0)$ with Continuity Correction**

This test statistic is similar to the one above except that a continuity correction is applied to make the normal distribution more closely approximate the binomial distribution.

$$ z_2 = \frac{(p - P_0) + c}{\sqrt{P_0(1 - P_0) / n}} $$

where

$$ c = \begin{cases} 
-\frac{1}{2n} & \text{if } p > P_0 \\
\frac{1}{2n} & \text{if } p < P_0 \\
0 & \text{if } |p - P_0| < \frac{1}{2n}
\end{cases} $$

**Z-Test using $S(\hat{p})$**

This test statistic uses the value of $p$ to compute $s$.

$$ z_3 = \frac{p - P_0}{\sqrt{p(1 - p) / n}} $$

**Z-Test using $S(\hat{p})$ with Continuity Correction**

This test statistic is similar to the one above except that a continuity correction is applied to make the normal distribution more closely approximate the binomial distribution.

$$ z_4 = \frac{(p - P_0) + c}{\sqrt{p(1 - p) / n}} $$
where
\[
c = \begin{cases} 
\frac{-1}{2n} & \text{if } p > P_0 \\
\frac{1}{2n} & \text{if } p < P_0 \\
0 & \text{if } |p - P_0| < \frac{1}{2n}
\end{cases}
\]

### Power Calculation

#### Normal Approximation Method

Power may be calculated for one-sample proportions tests using the normal approximation to the binomial distribution. This section provides the power calculation formulas for the various test statistics available in this procedure. In each case, power is presented for the lower and upper one-sided hypothesis tests and for the two-sided hypothesis test. In the equations that follow, \( \Phi() \) represents the standard normal cumulative distribution function, and \( z_\alpha \) represents the value that leaves \( \alpha \) in the upper tail of the standard normal distribution. All power values are evaluated at \( P = P_1 \).

#### Exact Test

Power for the two-sided hypothesis test of \( H_0: P = P_0 \) vs. \( H_1: P \neq P_0 \) is
\[
\text{Power}_{ET, \text{ Two-Sided}} = \Phi\left( \sqrt{n}(P_0 - P_1) - \frac{z_{\alpha/2}\sqrt{P_0(1 - P_0)FPC}}{\sqrt{P_1(1 - P_1)FPC}} \right) + 1 - \Phi\left( \sqrt{n}(P_0 - P_1) + \frac{z_{\alpha/2}\sqrt{P_0(1 - P_0)FPC}}{\sqrt{P_1(1 - P_1)FPC}} \right)
\]

where \( FPC = (N - n)/(N - 1) \) if the population size, \( N \), is finite, and \( FPC = 1 \) if the population size is infinite.

Power for the lower one-sided hypothesis test of \( H_0: P \geq P_0 \) vs. \( H_1: P < P_0 \) is
\[
\text{Power}_{ET, \text{ Lower One-Sided}} = \Phi\left( \sqrt{n}(P_0 - P_1) - \frac{z_\alpha\sqrt{P_0(1 - P_0)FPC}}{\sqrt{P_1(1 - P_1)FPC}} \right)
\]

Power for the upper one-sided hypothesis test of \( H_0: P \leq P_0 \) vs. \( H_1: P > P_0 \) is
\[
\text{Power}_{ET, \text{ Upper One-Sided}} = 1 - \Phi\left( \sqrt{n}(P_0 - P_1) + \frac{z_\alpha\sqrt{P_0(1 - P_0)FPC}}{\sqrt{P_1(1 - P_1)FPC}} \right)
\]

#### Z Test using S(P0)

Power for the two-sided hypothesis test of \( H_0: P = P_0 \) vs. \( H_1: P \neq P_0 \) is
\[
\text{Power}_{ZS(P_0), \text{ Two-Sided}} = \Phi\left( \sqrt{n}(P_0 - P_1) - \frac{z_{\alpha/2}\sqrt{P_0(1 - P_0)}}{\sqrt{P_1(1 - P_1)}} \right) + 1 - \Phi\left( \sqrt{n}(P_0 - P_1) + \frac{z_{\alpha/2}\sqrt{P_0(1 - P_0)}}{\sqrt{P_1(1 - P_1)}} \right)
\]

Power for the lower one-sided hypothesis test of \( H_0: P \geq P_0 \) vs. \( H_1: P < P_0 \) is
\[
\text{Power}_{ZS(P_0), \text{ Lower One-Sided}} = \Phi\left( \sqrt{n}(P_0 - P_1) - \frac{z_\alpha\sqrt{P_0(1 - P_0)}}{\sqrt{P_1(1 - P_1)}} \right)
\]
Tests for One Proportion

Power for the upper one-sided hypothesis test of $H_0: P \leq P_0$ vs. $H_1: P > P_0$ is

$$Power_{ZS(P_0), \text{ Upper One-Sided}} = 1 - \Phi\left(\frac{\sqrt{n}(P_0 - P_1) + z_\alpha\sqrt{P_0(1 - P_0)}}{P_1(1 - P_1)}\right)$$

Z Test using S(P0) with Continuity Correction

Power for the two-sided hypothesis test of $H_0: P = P_0$ vs. $H_1: P \neq P_0$ is

$$Power_{ZS(P_0)CC, \text{ Two-Sided}} = \Phi\left(\frac{\sqrt{n}(P_0 - P_1) - z_\alpha\sqrt{P_0(1 - P_0) - c}}{P_1(1 - P_1)}\right) + 1 - \Phi\left(\frac{\sqrt{n}(P_0 - P_1) + z_\alpha\sqrt{P_0(1 - P_0) + c}}{P_1(1 - P_1)}\right)$$

where $c = 1/2\sqrt{n}$ if $|P_1 - P_0| < 1/2n$ otherwise $c = 0$.

Power for the lower one-sided hypothesis test of $H_0: P \geq P_0$ vs. $H_1: P < P_0$ is

$$Power_{ZS(P_0)CC, \text{ Lower One-Sided}} = \Phi\left(\frac{\sqrt{n}(P_0 - P_1) - z_\alpha\sqrt{P_0(1 - P_0) - c}}{P_1(1 - P_1)}\right)$$

Power for the upper one-sided hypothesis test of $H_0: P \leq P_0$ vs. $H_1: P > P_0$ is

$$Power_{ZS(P_0)CC, \text{ Upper One-Sided}} = 1 - \Phi\left(\frac{\sqrt{n}(P_0 - P_1) + z_\alpha\sqrt{P_0(1 - P_0) + c}}{P_1(1 - P_1)}\right)$$

Z Test using S(Phat)

Power for the two-sided hypothesis test of $H_0: P = P_0$ vs. $H_1: P \neq P_0$ is

$$Power_{ZS(P_1)CC, \text{ Two-Sided}} = \Phi\left(\frac{\sqrt{n}(P_0 - P_1) - z_\alpha\sqrt{P_1(1 - P_1)}}{P_1(1 - P_1)}\right) + 1 - \Phi\left(\frac{\sqrt{n}(P_0 - P_1) + z_\alpha\sqrt{P_1(1 - P_1)}}{P_1(1 - P_1)}\right)$$

Power for the lower one-sided hypothesis test of $H_0: P \geq P_0$ vs. $H_1: P < P_0$ is

$$Power_{ZS(P_1)CC, \text{ Lower One-Sided}} = \Phi\left(\frac{\sqrt{n}(P_0 - P_1) - z_\alpha\sqrt{P_1(1 - P_1)}}{P_1(1 - P_1)}\right)$$

Power for the upper one-sided hypothesis test of $H_0: P \leq P_0$ vs. $H_1: P > P_0$ is

$$Power_{ZS(P_1)CC, \text{ Upper One-Sided}} = 1 - \Phi\left(\frac{\sqrt{n}(P_0 - P_1) + z_\alpha\sqrt{P_1(1 - P_1)}}{P_1(1 - P_1)}\right)$$

Z Test using S(Phat) with Continuity Correction

Power for the two-sided hypothesis test of $H_0: P = P_0$ vs. $H_1: P \neq P_0$ is

$$Power_{ZS(P_1)CC, \text{ Two-Sided}} = \Phi\left(\frac{\sqrt{n}(P_0 - P_1) - z_\alpha\sqrt{P_1(1 - P_1) - c}}{P_1(1 - P_1)}\right) + 1 - \Phi\left(\frac{\sqrt{n}(P_0 - P_1) + z_\alpha\sqrt{P_1(1 - P_1) + c}}{P_1(1 - P_1)}\right)$$

where $c = 1/2\sqrt{n}$ if $|P_1 - P_0| < 1/2n$ otherwise $c = 0$.

Power for the lower one-sided hypothesis test of $H_0: P \geq P_0$ vs. $H_1: P < P_0$ is

$$Power_{ZS(P_1)CC, \text{ Lower One-Sided}} = \Phi\left(\frac{\sqrt{n}(P_0 - P_1) - z_\alpha\sqrt{P_1(1 - P_1) - c}}{P_1(1 - P_1)}\right)$$
Tests for One Proportion

Power for the upper one-sided hypothesis test of \( H_0: P \leq P_0 \) vs. \( H_1: P > P_0 \) is

\[
Power_{ZS(P_1)CC, \; \text{upper one-sided}} = 1 - \Phi\left(\frac{\sqrt{n}(P_0 - P_1) + z_\alpha \sqrt{P_1(1 - P_1) + c}}{\sqrt{P_1(1 - P_1)}}\right)
\]

Steps to Calculate Power using Binomial Enumeration of All Possible Outcomes

The power calculation procedure is as follows. Let \( P \) represent the true probability that an item selected at random from a population will have a characteristic of interest.

1. **State the Hypotheses**

   \( H_0 \) is the null hypothesis that the proportion is \( P_0 \).

   \( H_1 \) is the alternative hypothesis that the proportion is \( P_1 \).

   Three sets of statistical hypotheses may be formulated:
   
   1. \( H_0: P = P_0 \) versus \( H_1: P = P_1 \neq P_0 \). This hypothesis results in a two-tailed test.
   2. \( H_0: P \leq P_0 \) versus \( H_1: P = P_1 > P_0 \). This hypothesis results in a one-tailed test.
   3. \( H_0: P \geq P_0 \) versus \( H_1: P = P_1 < P_0 \). This hypothesis results in a one-tailed test.

2. **Find the Critical Value**

   For an upper-tailed test with a given sample size find the critical value, \( P_c \), based on the binomial (or hypergeometric) distribution, so that the probability of rejecting \( H_0 \) when \( H_0 \) is true is equal to a specified significance level, \( \alpha \).

3. **Evaluate the Sample**

   Select a sample of \( n \) items from the population and compute the sample proportion, \( p = r / n \). If \( p > P_c \) then reject the null hypothesis that \( P = P_0 \) in favor of an alternative hypothesis that \( P = P_1 > P_0 \).

4. **Calculate the Power**

   The power is the probability of rejecting \( H_0 \) when the true proportion is \( P_1 \). That is, the power is the probability that \( p > P_c \) calculated from a binomial (or hypergeometric) distribution in which \( P = P_1 \).

   Similar steps are used for the lower-tail and two-tailed tests.
Procedure Options

This section describes the options that are specific to this procedure. These are located on the Design tab. For more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab

The Design tab contains the parameters associated with this test such as the proportions, sample sizes, alpha, and power.

Solve For

Solve For

This option specifies the parameter to be solved for using the other parameters. The parameters that may be selected are Power, Sample Size, and Effect Size.

Power Calculation

Power Calculation Method

Select the method to be used to calculate power. When the sample sizes are reasonably large (i.e. greater than 50) and the proportions are between 0.2 and 0.8 the two methods will give similar results. For smaller sample sizes and more extreme proportions (less than 0.2 or greater than 0.8), the normal approximation is not as accurate so the binomial calculations may be more appropriate.

The choices are

- **Binomial Enumeration**
  
  Power for each test is computed using binomial enumeration of all possible outcomes when \( n \leq \text{Max n for Binomial Enumeration} \) otherwise, the normal approximation is used. Binomial enumeration of all outcomes is possible because of the discrete nature of the data.

- **Normal Approximation**
  
  Approximate power for each test is computed using the normal approximation to the binomial distribution.

Actual alpha values are only computed when “Binomial Enumeration” is selected.

Max n for Binomial Enumeration

*Only shown when Power Calculation Method = “Binomial Enumeration”*

When \( n \) is less than or equal to this value, power is calculated using the binomial distribution and enumeration of all possible outcomes. This is possible because of the discrete nature of the data. “Actual Alpha” values are only computed when binomial power calculations are made.

When \( n \) is greater than this value, the normal approximation to the binomial is used when calculating power.
Tests for One Proportion

Test

Alternative Hypothesis
Specify whether the alternative hypothesis of the test is one-sided or two-sided. If a one-sided test is chosen, the hypothesis test direction is chosen based on whether P1 is greater than or less than P0.

- **Two-Sided Hypothesis Test**
  \[ H_0: P = P_0 \text{ vs. } H_1: P \neq P_0 \]

- **One-Sided Hypothesis Tests**
  - Upper: \[ H_0: P \leq P_0 \text{ vs. } H_1: P > P_0 \]
  - Lower: \[ H_0: P \geq P_0 \text{ vs. } H_1: P < P_0 \]

Test Type
Specify the type of test that will be used in reporting. Note that C.C. is short for *Continuity Correction*. This refers to the adding or subtracting \(1/(2n)\) to (or from) the numerator of the z-value to bring the normal approximation closer to the binomial distribution.

N (Population Size)
*Only shown when Test Type = “Exact Test”*
Enter the total number of items in the population from which the sample of \(n\) items is selected. Enter *Infinite* to signify an infinite population so that no correction factor is applied. An *infinite* population is generally one in which the number in the population is large and unknown.

Note that \(N\) must be greater than \(n\).

When samples are drawn from a very large (infinite) population, calculations are based on the binomial distribution.

When samples are drawn from a population of known size, specified here as \(N\), calculations are based on the hypergeometric distribution.

Power and Alpha

Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis, and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null hypothesis is not rejected.

Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now, 0.90 (Beta = 0.10) is also commonly used.

A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.

Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true null hypothesis is rejected. For this procedure, a type-I error occurs when you reject the null hypothesis of equal proportions when in fact they are equal.

Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means that about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents the risk of a type-I error you are willing to take in your experimental situation.
Note that because of the discrete nature of the binomial distribution, the alpha level rarely will be achieved exactly.

A single value may be entered here or a range of values such as 0.05 to 0.2 by 0.05 may be entered.

---

**Sample Size**

**n (Sample Size)**

This option specifies the total number of observations in the sample. Values must be integers greater than one.

You may enter a single value or a range of values such as 10, 50, 100 or 10 to 100 by 10.

---

**Effect Size**

**Input Type**

Indicate what type of values to enter to specify the effect size. Regardless of the entry type chosen, the test statistics used in the power and sample size calculations are the same. This option is simply given for convenience in specifying the effect size.

**P0 (Null Proportion)**

Enter a value (or range of values) for the population proportion under the null hypothesis, P0. This is the baseline proportion, the proportion that exists in the general population. The proportion estimated from the data will be compared to this value by the statistical test.

Proportions must be between zero and one.

You may enter a single value or a range of values such as 0.1 0.2 0.3 or 0.1 to 0.9 by 0.1.

**P1 (Alternative Proportion)**

Enter a value (or range of values) for the value of the binomial proportion at which the power is calculated. This is labeled P1 on the screen. Power calculations assume that this is the true value of the proportion. This value cannot be equal to P0. When solving for effect size, specify the search direction.

**P1–P0) Alternative Difference**

This option implicitly specifies the value of P1 (the proportion at which the power is calculated) by explicitly specifying the difference. The difference is used with P0 to calculate the value of P1 using the formula, P1 = diff + P0.

Since P1 is a proportion, the difference must be between −P0 and 1 − P0. The difference cannot be equal to zero. A single value or a range of values may be entered here. When solving for effect size, specify the search direction.

**P1/P0) Alternative Ratio**

This option implicitly specifies the value of P1 (the proportion at which the power is calculated) by explicitly specifying the ratio. The ratio is used with P0 to calculate the value of P1 using the formula, P1 = (P0) x (ratio).

Since P1 is a proportion, the ratio must be between 0 and 1 / P0. The ratio cannot be equal to one. A single value or a range of values may be entered here. When solving for effect size, specify the search direction.

**O1/O0) Alternative Odds Ratio**

This option implicitly specifies the value of P1 (the proportion at which the power is calculated) by explicitly specifying the odds ratio. Since P1 is a proportion, the odds ratio must be greater than zero. The odds ratio cannot be equal to one. A single value or a range of values may be entered here. When solving for effect size, specify the search direction.
Example 1 – Finding the Power

Suppose 50% of patients with a certain type of cancer survive five years. Researchers have developed a new treatment to increase the percentage of individuals that survive five years. Although the researchers do not know the true percentage of patients that will survive with the new treatment, they would like to examine the power that is achieved if the percentage under the new treatment is 60%. The power will be determined for trials with sample sizes of 50, 100, 200, 300, 500, or 800 and a significance level of 0.05. For comparative purposes, the power is also to be calculated for alternative proportions of 55% and 65%.

This is an example of a historically controlled trial. Historically controlled means that no control group is formed for the current study. Instead, the rates reported from previous studies or that are known to exist in the general population are used. Because of the many advantages that occur when an actual control group is used, historically controlled trials should only be used when a control group is either impossible to obtain or unethical.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Tests for One Proportion procedure window by expanding Proportions, then One Proportion, then Test (Inequality), and then clicking on Tests for One Proportion. You may then make the appropriate entries as listed below, or open Example 1 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Power</td>
</tr>
<tr>
<td>Power Calculation Method</td>
<td>Normal Approximation</td>
</tr>
<tr>
<td>Alternative Hypothesis</td>
<td>Two-Sided</td>
</tr>
<tr>
<td>Test Type</td>
<td>Z-test using S(P0)</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>n (Sample Size)</td>
<td>50 100 200 300 500 800</td>
</tr>
<tr>
<td>Input Type</td>
<td>Proportions</td>
</tr>
<tr>
<td>P0 (Null Proportion)</td>
<td>0.50</td>
</tr>
<tr>
<td>P1 (Alternative Proportion)</td>
<td>0.55 0.60 0.65</td>
</tr>
</tbody>
</table>
## Output

Click the Calculate button to perform the calculations and generate the following output.

### Numeric Results

**Numeric Results for Testing One Proportion using the Z-Test with S(P0)**  
Alternative Hypothesis: Two-Sided  \((H_0: P = P_0 \text{ vs. } H_1: P \neq P_0)\)

<table>
<thead>
<tr>
<th>Power*</th>
<th>n</th>
<th>Proportion Given H0</th>
<th>Proportion Given H1</th>
<th>Difference</th>
<th>Alpha</th>
<th>Reject H0 If</th>
<th>Z</th>
<th>&gt;</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.10766</td>
<td>50</td>
<td>0.5000</td>
<td>0.5500</td>
<td>0.0500</td>
<td>0.0500</td>
<td>1.9600</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.28905</td>
<td>50</td>
<td>0.5000</td>
<td>0.6000</td>
<td>0.1000</td>
<td>0.0500</td>
<td>1.9600</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.56717</td>
<td>50</td>
<td>0.5000</td>
<td>0.6500</td>
<td>0.1500</td>
<td>0.0500</td>
<td>1.9600</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.16879</td>
<td>100</td>
<td>0.5000</td>
<td>0.5500</td>
<td>0.0500</td>
<td>0.0500</td>
<td>1.9600</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.51632</td>
<td>100</td>
<td>0.5000</td>
<td>0.6000</td>
<td>0.1000</td>
<td>0.0500</td>
<td>1.9600</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.86220</td>
<td>100</td>
<td>0.5000</td>
<td>0.6500</td>
<td>0.1500</td>
<td>0.0500</td>
<td>1.9600</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.29202</td>
<td>200</td>
<td>0.5000</td>
<td>0.5500</td>
<td>0.0500</td>
<td>0.0500</td>
<td>1.9600</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.81229</td>
<td>200</td>
<td>0.5000</td>
<td>0.6000</td>
<td>0.1000</td>
<td>0.0500</td>
<td>1.9600</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.99164</td>
<td>200</td>
<td>0.5000</td>
<td>0.6500</td>
<td>0.1500</td>
<td>0.0500</td>
<td>1.9600</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.40951</td>
<td>200</td>
<td>0.5000</td>
<td>0.5500</td>
<td>0.0500</td>
<td>0.0500</td>
<td>1.9600</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.93763</td>
<td>300</td>
<td>0.5000</td>
<td>0.6000</td>
<td>0.1000</td>
<td>0.0500</td>
<td>1.9600</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.99965</td>
<td>300</td>
<td>0.5000</td>
<td>0.6500</td>
<td>0.1500</td>
<td>0.0500</td>
<td>1.9600</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.60931</td>
<td>500</td>
<td>0.5000</td>
<td>0.5500</td>
<td>0.0500</td>
<td>0.0500</td>
<td>1.9600</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.99483</td>
<td>500</td>
<td>0.5000</td>
<td>0.6000</td>
<td>0.1000</td>
<td>0.0500</td>
<td>1.9600</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.00000</td>
<td>500</td>
<td>0.5000</td>
<td>0.6500</td>
<td>0.1500</td>
<td>0.0500</td>
<td>1.9600</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.80863</td>
<td>800</td>
<td>0.5000</td>
<td>0.5500</td>
<td>0.0500</td>
<td>0.0500</td>
<td>1.9600</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.99992</td>
<td>800</td>
<td>0.5000</td>
<td>0.6000</td>
<td>0.1000</td>
<td>0.0500</td>
<td>1.9600</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.00000</td>
<td>800</td>
<td>0.5000</td>
<td>0.6500</td>
<td>0.1500</td>
<td>0.0500</td>
<td>1.9600</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* Power was computed using the normal approximation method.

**References**


**Report Definitions**

- **Power** is the probability of rejecting the null hypothesis when it is false. It should be close to one.
- **n** is the size of the sample drawn from the population. To conserve resources, it should be as small as possible.
- **P0** is the value of the population proportion under the null hypothesis.
- **P1** is the value of the population proportion under the alternative hypothesis.
- **P1-P0** is the difference to be detected by the study.
- **Alpha** (significance level) is the probability of rejecting the null hypothesis when it is true. It should be small.
- **Reject H0 If...** gives the critical value(s) for the test.

**Summary Statements**

A sample size of 50 achieves 10.766% power to detect a difference (P1-P0) of 0.0500 using a two-sided Z-test that uses S(P0) to estimate the standard deviation with a significance level (alpha) of 0.0500. These results assume that the population proportion under the null hypothesis (P0) is 0.5000.
These plots show the relationship between power, sample size, and P1 in this example. We note that 80% power is achieved with a sample size of about 200 when P1 is 0.60, which was the specific value of interest.
Example 2 – Finding the Sample Size

Continuing with Example 1, suppose you want to study the impact of various choices for P1 on sample size. Using a significance level of 0.05 and 90% power, find the sample size when P1 is 0.55, 0.60, 0.65, 0.70, 0.75, and 0.80. Assume that an two-tailed Z-test using S(P0) will be used.

In this example we’ll show you how to setup the calculation by inputting proportions, differences, ratios, and odds ratios. In all cases, you’ll see that the sample sizes are exactly the same. The only difference is in the way P1 is specified.

Setup (Proportions)

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Tests for One Proportion procedure window by expanding Proportions, then One Proportion, then Test (Inequality), and then clicking on Tests for One Proportion. You may then make the appropriate entries as listed below, or open Example 2a by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td>Sample Size</td>
</tr>
<tr>
<td>Solve For</td>
<td>Sample Size</td>
</tr>
<tr>
<td>Power Calculation Method</td>
<td>Normal Approximation</td>
</tr>
<tr>
<td>Alternative Hypothesis</td>
<td>Two-Sided</td>
</tr>
<tr>
<td>Test Type</td>
<td>Z-test using S(P0)</td>
</tr>
<tr>
<td>Power</td>
<td>0.90</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>Input Type</td>
<td>Proportions</td>
</tr>
<tr>
<td>P0 (Null Proportion)</td>
<td>0.50</td>
</tr>
<tr>
<td>P1 (Alternative Proportion)</td>
<td>0.55 to 0.80 by 0.05</td>
</tr>
</tbody>
</table>

Output (Proportions)

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

Here are the numeric results for testing one proportion using the Z-test with S(P0).

<table>
<thead>
<tr>
<th>Power*</th>
<th>n</th>
<th>Proportion Given H0</th>
<th>Proportion Given H1</th>
<th>Difference</th>
<th>Alpha</th>
<th>Reject H0</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.90011</td>
<td>1047</td>
<td>0.5000</td>
<td>0.5500</td>
<td>0.0500</td>
<td>0.0500</td>
<td>1.9600</td>
</tr>
<tr>
<td>0.90055</td>
<td>259</td>
<td>0.5000</td>
<td>0.6000</td>
<td>0.1000</td>
<td>0.0500</td>
<td>1.9600</td>
</tr>
<tr>
<td>0.90120</td>
<td>113</td>
<td>0.5000</td>
<td>0.6500</td>
<td>0.1500</td>
<td>0.0500</td>
<td>1.9600</td>
</tr>
<tr>
<td>0.90286</td>
<td>62</td>
<td>0.5000</td>
<td>0.7000</td>
<td>0.2000</td>
<td>0.0500</td>
<td>1.9600</td>
</tr>
<tr>
<td>0.90249</td>
<td>38</td>
<td>0.5000</td>
<td>0.7500</td>
<td>0.2500</td>
<td>0.0500</td>
<td>1.9600</td>
</tr>
<tr>
<td>0.90321</td>
<td>25</td>
<td>0.5000</td>
<td>0.8000</td>
<td>0.3000</td>
<td>0.0500</td>
<td>1.9600</td>
</tr>
</tbody>
</table>

* Power was computed using the normal approximation method.

This report shows the sample sizes corresponding to various values of P1. Notice that a sample size of only 25 is needed to detect the difference between 0.5 and 0.8, but a sample size of 1047 is needed to detect the difference between 0.50 and 0.55.
Setup (Differences)

The setup for differences is exactly the same as that for proportions except for the following two inputs on the Design tab. You may then make the appropriate entries as listed below, or open Example 2b by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Input Type...............</td>
<td>Differences</td>
</tr>
<tr>
<td>P1 (Alternative Difference)</td>
<td>0.05 to 0.3 by 0.05</td>
</tr>
</tbody>
</table>

Output (Differences)

Click the Calculate button to perform the calculations and generate the following output.

**Numeric Results**

<table>
<thead>
<tr>
<th>Power*</th>
<th>n</th>
<th>Proportion Given H0 P0</th>
<th>Proportion Given H1 P1</th>
<th>Difference</th>
<th>Alpha</th>
<th>If</th>
<th>Reject H0</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.90011</td>
<td>1047</td>
<td>0.5000</td>
<td>0.5500</td>
<td>0.0500</td>
<td>0.0500</td>
<td>1.9600</td>
<td></td>
</tr>
<tr>
<td>0.90055</td>
<td>259</td>
<td>0.5000</td>
<td>0.6000</td>
<td>0.1000</td>
<td>0.0500</td>
<td>1.9600</td>
<td></td>
</tr>
<tr>
<td>0.90120</td>
<td>113</td>
<td>0.5000</td>
<td>0.6500</td>
<td>0.1500</td>
<td>0.0500</td>
<td>1.9600</td>
<td></td>
</tr>
<tr>
<td>0.90286</td>
<td>62</td>
<td>0.5000</td>
<td>0.7000</td>
<td>0.2000</td>
<td>0.0500</td>
<td>1.9600</td>
<td></td>
</tr>
<tr>
<td>0.90249</td>
<td>38</td>
<td>0.5000</td>
<td>0.7500</td>
<td>0.2500</td>
<td>0.0500</td>
<td>1.9600</td>
<td></td>
</tr>
<tr>
<td>0.90321</td>
<td>25</td>
<td>0.5000</td>
<td>0.8000</td>
<td>0.3000</td>
<td>0.0500</td>
<td>1.9600</td>
<td></td>
</tr>
</tbody>
</table>

* Power was computed using the normal approximation method.

This report shows the sample sizes corresponding to various values of P1 entered indirectly as differences.

Setup (Ratios)

The setup for ratios is exactly the same as that for proportions except for the following two inputs on the Design tab. You may then make the appropriate entries as listed below, or open Example 2c by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Input Type...............</td>
<td>Ratios</td>
</tr>
<tr>
<td>P1 (Alternative Ratio)</td>
<td>1.1 to 1.6 by 0.1</td>
</tr>
</tbody>
</table>
Output (Ratios)

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th>Power*</th>
<th>n</th>
<th>P0</th>
<th>P1</th>
<th>Ratio</th>
<th>Reject H0</th>
<th>If</th>
<th>Z</th>
<th>&gt;</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.90011</td>
<td>1047</td>
<td>0.5000</td>
<td>0.5500</td>
<td>1.1000</td>
<td>0.0500</td>
<td>1.9600</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.90055</td>
<td>259</td>
<td>0.5000</td>
<td>0.6000</td>
<td>1.2000</td>
<td>0.0500</td>
<td>1.9600</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.90120</td>
<td>113</td>
<td>0.5000</td>
<td>0.6500</td>
<td>1.3000</td>
<td>0.0500</td>
<td>1.9600</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.90268</td>
<td>62</td>
<td>0.5000</td>
<td>0.7000</td>
<td>1.4000</td>
<td>0.0500</td>
<td>1.9600</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.90249</td>
<td>38</td>
<td>0.5000</td>
<td>0.7500</td>
<td>1.5000</td>
<td>0.0500</td>
<td>1.9600</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.90321</td>
<td>25</td>
<td>0.5000</td>
<td>0.8000</td>
<td>1.6000</td>
<td>0.0500</td>
<td>1.9600</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* Power was computed using the normal approximation method.

This report shows the sample sizes corresponding to various values of P1 entered indirectly as ratios.

Setup (Odds Ratios)

The setup for odds ratios is exactly the same as that for proportions except for the following two inputs on the Design tab. You may then make the appropriate entries as listed below, or open Example 2d by going to the File menu and choosing Open Example Template.

Option | Value
---|---
Design Tab | Odds Ratios
Input Type | 1.2222 1.5 1.8571 2.3333 3 4
P1 (Alternative Odds Ratio) | 1.2222 1.5 1.8571 2.3333 3 4

Output (Odds Ratios)

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th>Power*</th>
<th>n</th>
<th>P0</th>
<th>P1</th>
<th>Odds Ratio</th>
<th>Reject H0</th>
<th>If</th>
<th>Z</th>
<th>&gt;</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.90006</td>
<td>1047</td>
<td>0.5000</td>
<td>0.5500</td>
<td>1.2222</td>
<td>0.0500</td>
<td>1.9600</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.90055</td>
<td>259</td>
<td>0.5000</td>
<td>0.6000</td>
<td>1.5000</td>
<td>0.0500</td>
<td>1.9600</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.90116</td>
<td>113</td>
<td>0.5000</td>
<td>0.6500</td>
<td>1.8571</td>
<td>0.0500</td>
<td>1.9600</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.90268</td>
<td>62</td>
<td>0.5000</td>
<td>0.7000</td>
<td>2.3333</td>
<td>0.0500</td>
<td>1.9600</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.90249</td>
<td>38</td>
<td>0.5000</td>
<td>0.7500</td>
<td>3.0000</td>
<td>0.0500</td>
<td>1.9600</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.90321</td>
<td>25</td>
<td>0.5000</td>
<td>0.8000</td>
<td>4.0000</td>
<td>0.0500</td>
<td>1.9600</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* Power was computed using the normal approximation method.

This report shows the sample sizes corresponding to various values of P1 entered indirectly as odds ratios.
Example 3 – Investigating the Saw-Tooth Power Function

After releasing the first version of PASS, we received many inquiries about the strange shape of the relationship between sample size and power computed using binomial enumeration of all possible outcomes when testing a single proportion using the exact test. This example will show why this strange shape occurs.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Tests for One Proportion procedure window by expanding Proportions, then One Proportion, then Test (Inequality), and then clicking on Tests for One Proportion. You may then make the appropriate entries as listed below, or open Example 3 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Power</td>
</tr>
<tr>
<td>Power Calculation Method</td>
<td>Binomial Enumeration</td>
</tr>
<tr>
<td>Max n for Binomial Enumeration</td>
<td>10000</td>
</tr>
<tr>
<td>Alternative Hypothesis</td>
<td>Two-Sided</td>
</tr>
<tr>
<td>Test Type</td>
<td>Exact Test</td>
</tr>
<tr>
<td>N (Population Size)</td>
<td>Infinite</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>n (Sample Size)</td>
<td>51 to 60 by 1</td>
</tr>
<tr>
<td>Input Type</td>
<td>Proportions</td>
</tr>
<tr>
<td>P0 (Null Proportion)</td>
<td>0.60</td>
</tr>
<tr>
<td>P1 (Alternative Proportion)</td>
<td>0.70</td>
</tr>
</tbody>
</table>

Output

Click the Calculate button to perform the calculations and generate the following output.

**Numeric Results**

<table>
<thead>
<tr>
<th>Power*</th>
<th>n</th>
<th>P0</th>
<th>P1</th>
<th>Difference</th>
<th>Target Alpha</th>
<th>Actual Alpha*</th>
<th>Reject H0</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.29656</td>
<td>51</td>
<td>0.6000</td>
<td>0.7000</td>
<td>0.1000</td>
<td>0.0500</td>
<td>0.0443</td>
<td>23</td>
</tr>
<tr>
<td>0.26688</td>
<td>52</td>
<td>0.6000</td>
<td>0.7000</td>
<td>0.1000</td>
<td>0.0500</td>
<td>0.0328</td>
<td>23</td>
</tr>
<tr>
<td>0.23931</td>
<td>53</td>
<td>0.6000</td>
<td>0.7000</td>
<td>0.1000</td>
<td>0.0500</td>
<td>0.0348</td>
<td>24</td>
</tr>
<tr>
<td>0.31244</td>
<td>54</td>
<td>0.6000</td>
<td>0.7000</td>
<td>0.1000</td>
<td>0.0500</td>
<td>0.0371</td>
<td>24</td>
</tr>
<tr>
<td>0.28284</td>
<td>55</td>
<td>0.6000</td>
<td>0.7000</td>
<td>0.1000</td>
<td>0.0500</td>
<td>0.0379</td>
<td>25</td>
</tr>
<tr>
<td>0.25494</td>
<td>56</td>
<td>0.6000</td>
<td>0.7000</td>
<td>0.1000</td>
<td>0.0500</td>
<td>0.0281</td>
<td>25</td>
</tr>
<tr>
<td>0.32774</td>
<td>57</td>
<td>0.6000</td>
<td>0.7000</td>
<td>0.1000</td>
<td>0.0500</td>
<td>0.0417</td>
<td>26</td>
</tr>
<tr>
<td>0.29806</td>
<td>58</td>
<td>0.6000</td>
<td>0.7000</td>
<td>0.1000</td>
<td>0.0500</td>
<td>0.0314</td>
<td>26</td>
</tr>
<tr>
<td>0.27013</td>
<td>59</td>
<td>0.6000</td>
<td>0.7000</td>
<td>0.1000</td>
<td>0.0500</td>
<td>0.0327</td>
<td>27</td>
</tr>
<tr>
<td>0.34228</td>
<td>60</td>
<td>0.6000</td>
<td>0.7000</td>
<td>0.1000</td>
<td>0.0500</td>
<td>0.0354</td>
<td>27</td>
</tr>
</tbody>
</table>

* Power and actual alpha were computed using binomial enumeration of all possible outcomes.
Tests for One Proportion

This report shows the values of each of the parameters, one scenario per row. The symbol, $R$, stands for the number of items with the characteristic of interest out of the $n$ items sampled. Hence, for the scenario presented on the first line, an exact test does not exist for these parameters at the target alpha of 0.05. The closest that can be achieved is an alpha of 0.0443. In this case, we would reject the null hypothesis in any sample of size 51 in which the count of individuals with the characteristic of interest is less than or equal to 23 or greater than or equal to 38. The values from this table are plotted in the chart below.

Chart Section

Notice that the power decreases as $n$ increases from 51 to 52 and continues to decrease as $n$ increases to 53. Usually, the power increases as the sample size increases.

To understand why this happens, look at the last column and at the Actual Alpha column. Note that at $n = 51$, the actual alpha is 0.0443 and at $n = 52$, the actual alpha has decreased to 0.0328. Remember that as alpha decreases, power decreases as well. Hence, increasing the sample size from 51 to 52 was not enough to counterbalance the effect on power of a decrease in alpha from 0.04428 to 0.03281. Hence, the power drops from 0.29656 to 0.26688.

This phenomenon usually occurs for relatively small values of $n$. 
Example 4 – Step-by-Step Calculations

In this example, we will take you step by step through the calculations necessary to compute the power of a specific scenario using binomial enumeration of all possible outcomes. We will set $n = 10$, $P_0 = 0.50$, $P_1 = 0.80$, and alpha = 0.05. We will compute the power of the two-tailed test.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Tests for One Proportion procedure window by expanding Proportions, then One Proportion, then Test (Inequality), and then clicking on Tests for One Proportion. You may then make the appropriate entries as listed below, or open Example 4 by going to the File menu and choosing Open Example Template.

Option  
Value

Design Tab
Solve For ................................................ Power
Power Calculation Method...................... Binomial Enumeration
Max n for Binomial Enumeration .......... 10000
Alternative Hypothesis ...................... Two-Sided
Test Type ................................................ Exact Test
N (Population Size) .................. Infinite
Alpha .................................................... 0.05
n (Sample Size) ..................... 10
Input Type ............................................ Proportions
P0 (Null Proportion) .................. 0.50
P1 (Alternative Proportion) .................. 0.8

Reports Tab
Power Decimals .................. 6
Alpha Decimals .................. 6
Proportions Decimals ............ 6

Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

We will now proceed through the calculations necessary to compute this power value.
Tests for One Proportion

We first construct a table of binomial probabilities for \( n = 10 \) and \( p = 0.5 \) using the formula

\[
 b(r;10,0.5) = \binom{10}{r} 0.5^r (1 - 0.5)^{10-r}
\]

### Binomial Probabilities for \( n = 10 \) and \( p = 0.5 \)

<table>
<thead>
<tr>
<th>R</th>
<th>Prob(r = R)</th>
<th>Cumulative Total</th>
<th>1 – Cumulative Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0.000977</td>
<td>0.000977</td>
<td>0.999023</td>
</tr>
<tr>
<td>1</td>
<td>0.009766</td>
<td>0.010742</td>
<td>0.989258</td>
</tr>
<tr>
<td>2</td>
<td>0.043945</td>
<td>0.054688</td>
<td>0.945313</td>
</tr>
<tr>
<td>3</td>
<td>0.117188</td>
<td>0.171875</td>
<td>0.828125</td>
</tr>
<tr>
<td>4</td>
<td>0.205078</td>
<td>0.376953</td>
<td>0.623047</td>
</tr>
<tr>
<td>5</td>
<td>0.246094</td>
<td>0.623047</td>
<td>0.376953</td>
</tr>
<tr>
<td>6</td>
<td>0.205078</td>
<td>0.828125</td>
<td>0.171875</td>
</tr>
<tr>
<td>7</td>
<td>0.117188</td>
<td>0.945313</td>
<td>0.054688</td>
</tr>
<tr>
<td>8</td>
<td>0.043945</td>
<td>0.989258</td>
<td>0.010742</td>
</tr>
<tr>
<td>9</td>
<td>0.009766</td>
<td>0.999023</td>
<td>0.000977</td>
</tr>
<tr>
<td>10</td>
<td>0.000977</td>
<td>1.000000</td>
<td>0.000000</td>
</tr>
</tbody>
</table>

When we construct a two-tailed test, we split the alpha value evenly between the two tails. Hence, we place \( \alpha / 2 \) (or 0.025) in each tail. Moving down from the top, we find that the cumulative probability is 0.010742 for \( R = 1 \) and 0.054688 for \( R = 2 \). Since 0.054688 is greater than 0.025, we adopt \( R = 1 \) as our lower rejection value. Likewise, we find that \( R = 9 \) is the upper rejection value.

Our testing strategy is

1. Draw a sample of 10 items and count the number with the characteristic of interest. Call this value \( r \).

2. If \( r = 0, 1, 9, \) or 10, reject the null hypothesis that \( p = 0.5 \) in favor of the alternative hypothesis that \( p \neq 0.5 \).

Now, to compute the power for \( P_1 = 0.8 \), we must compute another table of binomial probabilities, this time for \( p = 0.8 \) using the formula.

\[
 b(r;10,0.8) = \binom{10}{r} 0.8^r (1 - 0.8)^{10-r}
\]

### Binomial Probabilities for \( n = 10 \) and \( p = 0.8 \)

<table>
<thead>
<tr>
<th>R</th>
<th>Prob(r = R)</th>
<th>Cumulative Total</th>
<th>1 - Cumulative Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0.000000</td>
<td>0.000000</td>
<td>1.000000</td>
</tr>
<tr>
<td>1</td>
<td>0.000004</td>
<td>0.000004</td>
<td>0.999996</td>
</tr>
<tr>
<td>2</td>
<td>0.000074</td>
<td>0.000078</td>
<td>0.999922</td>
</tr>
<tr>
<td>3</td>
<td>0.000786</td>
<td>0.000864</td>
<td>0.999136</td>
</tr>
<tr>
<td>4</td>
<td>0.005505</td>
<td>0.006369</td>
<td>0.993631</td>
</tr>
<tr>
<td>5</td>
<td>0.026424</td>
<td>0.032793</td>
<td>0.967207</td>
</tr>
<tr>
<td>6</td>
<td>0.088080</td>
<td>0.120874</td>
<td>0.879126</td>
</tr>
<tr>
<td>7</td>
<td>0.201327</td>
<td>0.322200</td>
<td>0.677800</td>
</tr>
<tr>
<td>8</td>
<td>0.301990</td>
<td>0.624190</td>
<td>0.375810</td>
</tr>
<tr>
<td>9</td>
<td>0.268435</td>
<td>0.892626</td>
<td>0.107374</td>
</tr>
<tr>
<td>10</td>
<td>0.107374</td>
<td>1.000000</td>
<td>0.000000</td>
</tr>
</tbody>
</table>

The power is the probability of rejecting the null hypothesis. This occurs when \( r = 0, 1, 9, \) or 10. From the above table, we compute the power as \( 0.000000 + 0.000004 + 0.268435 + 0.107374 = 0.375813 \). This matches the calculated power value as displayed in the results above to within rounding error.
Example 5 – Comparing Test Statistics

One important decision that must be made before conducting the experiment is to decide which of the available test statistics to use. This procedure makes it easy to make this comparison. The alternative proportion will be set to 0.60 and the sample sizes will be 10, 11, 12, 25, 50, and 70. We’ll also calculate exact power using binomial enumeration.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Tests for One Proportion procedure window by expanding Proportions, then One Proportion, then Test (Inequality), and then clicking on Tests for One Proportion. You may then make the appropriate entries as listed below, or open Example 5 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Power</td>
</tr>
<tr>
<td>Power Calculation Method</td>
<td>Binomial Enumeration</td>
</tr>
<tr>
<td>Max n for Binomial Enumeration</td>
<td>10000</td>
</tr>
<tr>
<td>Alternative Hypothesis</td>
<td>Two-Sided</td>
</tr>
<tr>
<td>Test Type</td>
<td>Exact Test</td>
</tr>
<tr>
<td>N (Population Size)</td>
<td>Infinite</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>n (Sample Size)</td>
<td>10 11 12 25 50 70</td>
</tr>
<tr>
<td>Input Type</td>
<td>Proportions</td>
</tr>
<tr>
<td>P0 (Null Proportion)</td>
<td>0.50</td>
</tr>
<tr>
<td>P1 (Alternative Proportion)</td>
<td>0.6</td>
</tr>
</tbody>
</table>

Reports Tab

Show Comparative Reports.............. Checked

Comparative Plots Tab

Show Comparative Plots ............... Checked

Output

Click the Calculate button to perform the calculations and generate the following output.

**Numeric Results and Plots**

<table>
<thead>
<tr>
<th>n</th>
<th>P0</th>
<th>P1</th>
<th>Target Alpha</th>
<th>Exact Test S(P0)</th>
<th>Z-Test S(P0)</th>
<th>Z-Test S(P0)C</th>
<th>Z-Test S(P)</th>
<th>Z-Test S(P)C</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>0.5000</td>
<td>0.6000</td>
<td>0.0500</td>
<td>0.04804</td>
<td>0.04804</td>
<td>0.17958</td>
<td>0.17958</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>0.5000</td>
<td>0.6000</td>
<td>0.0500</td>
<td>0.03097</td>
<td>0.12484</td>
<td>0.12484</td>
<td>0.12484</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>0.5000</td>
<td>0.6000</td>
<td>0.0500</td>
<td>0.08625</td>
<td>0.08625</td>
<td>0.08625</td>
<td>0.08625</td>
<td></td>
</tr>
<tr>
<td>25</td>
<td>0.5000</td>
<td>0.6000</td>
<td>0.0500</td>
<td>0.15476</td>
<td>0.15476</td>
<td>0.15476</td>
<td>0.15476</td>
<td></td>
</tr>
<tr>
<td>50</td>
<td>0.5000</td>
<td>0.6000</td>
<td>0.0500</td>
<td>0.23706</td>
<td>0.33613</td>
<td>0.23706</td>
<td>0.33613</td>
<td></td>
</tr>
<tr>
<td>70</td>
<td>0.5000</td>
<td>0.6000</td>
<td>0.0500</td>
<td>0.36009</td>
<td>0.36009</td>
<td>0.45495</td>
<td>0.36009</td>
<td></td>
</tr>
</tbody>
</table>

Note: Power was computed using binomial enumeration of all possible outcomes.
An examination of the first report shows that for most sample sizes, the power is different for at least one of the tests. Also, notice that the exact test always has the minimum power in each row. This would lead us discard this test statistic. However, consider the second report, which shows the actual alpha level (the target was 0.05) for each test. By inspecting corresponding entries in both tables, we can see that whenever a test statistic achieves a better power than the exact test, it also exceeds the target alpha. For example, look at the powers for $n = 12$. The $z$-test using $s(p \hat{)}$ has an unusually large power of 0.24060. This is a much larger power than the exact test’s value of 0.08625. However, note that the actual alpha level for this test is 0.1460, which is much higher than the target of 0.05 and the actual alpha values of the other tests, which are 0.0328.

We still would conclude that indeed, the exact test is consistently the best test since it always achieves a significance level that is less than the target value.
Example 6 – Comparing Power Calculation Methods

Continuing with Example 5, let’s see how the results compare if we were to use approximate power calculations instead of power calculations based on binomial enumeration.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Tests for One Proportion procedure window by expanding Proportions, then One Proportion, then Test (Inequality), and then clicking on Tests for One Proportion. You may then make the appropriate entries as listed below, or open Example 6 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Power</td>
</tr>
<tr>
<td>Power Calculation Method</td>
<td>Binomial Enumeration</td>
</tr>
<tr>
<td>Max n for Binomial Enumeration</td>
<td>10000</td>
</tr>
<tr>
<td>Alternative Hypothesis</td>
<td>Two-Sided</td>
</tr>
<tr>
<td>Test Type</td>
<td>Exact Test</td>
</tr>
<tr>
<td>N (Population Size)</td>
<td>Infinite</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>n (Sample Size)</td>
<td>10 11 12 25 50 70</td>
</tr>
<tr>
<td>Input Type</td>
<td>Proportions</td>
</tr>
<tr>
<td>P0 (Null Proportion)</td>
<td>0.50</td>
</tr>
<tr>
<td>P1 (Alternative Proportion)</td>
<td>0.6</td>
</tr>
</tbody>
</table>

Reports Tab

Show Power Detail Report Checked

Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results and Plots

Power Detail Report for Testing One Proportion using the Exact Test

<table>
<thead>
<tr>
<th>n</th>
<th>P0</th>
<th>P1</th>
<th>P1-P0</th>
<th>Normal Approximation</th>
<th>Binomial Enumeration</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>0.5000</td>
<td>0.6000</td>
<td>0.1000</td>
<td>0.09180</td>
<td>0.04804</td>
</tr>
<tr>
<td>11</td>
<td>0.5000</td>
<td>0.6000</td>
<td>0.1000</td>
<td>0.09657</td>
<td>0.03907</td>
</tr>
<tr>
<td>12</td>
<td>0.5000</td>
<td>0.6000</td>
<td>0.1000</td>
<td>0.10135</td>
<td>0.08625</td>
</tr>
<tr>
<td>25</td>
<td>0.5000</td>
<td>0.6000</td>
<td>0.1000</td>
<td>0.16485</td>
<td>0.15476</td>
</tr>
<tr>
<td>50</td>
<td>0.5000</td>
<td>0.6000</td>
<td>0.1000</td>
<td>0.28905</td>
<td>0.23706</td>
</tr>
<tr>
<td>70</td>
<td>0.5000</td>
<td>0.6000</td>
<td>0.1000</td>
<td>0.38504</td>
<td>0.36009</td>
</tr>
</tbody>
</table>

Notice that the approximate power values consistently overestimate the power, particularly for small sample sizes. As the sample size increases, the approximate power values come nearer to the power values from binomial enumeration.
Example 7 – Determining the Power after Completing an Experiment

A group of researchers is studying the effects of a new diet on cholesterol levels in high-risk patients. The researchers had hypothesized that the cholesterol level would be reduced to a safe level in more than 70% of subjects following the new diet. They are confident that the proportion will be no less than 0.70. To test this one-sided hypothesis, they randomly sampled 200 individuals with dangerously high cholesterol and put them on the new diet. After the period of the study, the researchers determined that 150 of the 200 patients sampled (75%) had reduced their cholesterol level while on the new diet. Statistical analysis using the z-test with S(P0) and an alpha level of 0.05, however, resulted in failure to reject the null hypothesis that the proportion is 0.70. The researchers desire now to compute the power of their study for true proportions ranging from 0.71 to 0.80.

Note that a range of proportions is considered for power calculations instead of just 0.75, the sample proportion found in the experiment. While it is tempting to use the sample proportion as the true proportion in post-experiment power calculations, it is more informative to review a range of possible alternatives representing practically significant differences from the null value.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Tests for One Proportion procedure window by expanding Proportions, then One Proportion, then Test (Inequality), and then clicking on Tests for One Proportion. You may then make the appropriate entries as listed below, or open Example 7 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Power</td>
</tr>
<tr>
<td>Power Calculation Method</td>
<td>Normal Approximation</td>
</tr>
<tr>
<td>Alternative Hypothesis</td>
<td>One-Sided</td>
</tr>
<tr>
<td>Test Type</td>
<td>Z-test using S(P0)</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>n (Sample Size)</td>
<td>200</td>
</tr>
<tr>
<td>Input Type</td>
<td>Proportions</td>
</tr>
<tr>
<td>P0 (Null Proportion)</td>
<td>0.70</td>
</tr>
<tr>
<td>P1 (Alternative Proportion)</td>
<td>0.71 to 0.80 by 0.01</td>
</tr>
</tbody>
</table>
Output

Click the Calculate button to perform the calculations and generate the following output.

### Numeric Results

<table>
<thead>
<tr>
<th>Power*</th>
<th>n</th>
<th>Proportion Given H0</th>
<th>Proportion Given H1</th>
<th>Difference</th>
<th>Alpha</th>
<th>Reject H0 If Z &gt;</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.08859</td>
<td>200</td>
<td>0.7000</td>
<td>0.7100</td>
<td>0.0100</td>
<td>0.0500</td>
<td>1.6449</td>
</tr>
<tr>
<td>0.14171</td>
<td>200</td>
<td>0.7000</td>
<td>0.7200</td>
<td>0.0200</td>
<td>0.0500</td>
<td>1.6449</td>
</tr>
<tr>
<td>0.22899</td>
<td>200</td>
<td>0.7000</td>
<td>0.7300</td>
<td>0.0300</td>
<td>0.0500</td>
<td>1.6449</td>
</tr>
<tr>
<td>0.33404</td>
<td>200</td>
<td>0.7000</td>
<td>0.7400</td>
<td>0.0400</td>
<td>0.0500</td>
<td>1.6449</td>
</tr>
<tr>
<td>0.45709</td>
<td>200</td>
<td>0.7000</td>
<td>0.7500</td>
<td>0.0500</td>
<td>0.0500</td>
<td>1.6449</td>
</tr>
<tr>
<td>0.58780</td>
<td>200</td>
<td>0.7000</td>
<td>0.7600</td>
<td>0.0600</td>
<td>0.0500</td>
<td>1.6449</td>
</tr>
<tr>
<td>0.71268</td>
<td>200</td>
<td>0.7000</td>
<td>0.7700</td>
<td>0.0700</td>
<td>0.0500</td>
<td>1.6449</td>
</tr>
<tr>
<td>0.81900</td>
<td>200</td>
<td>0.7000</td>
<td>0.7800</td>
<td>0.0800</td>
<td>0.0500</td>
<td>1.6449</td>
</tr>
<tr>
<td>0.89872</td>
<td>200</td>
<td>0.7000</td>
<td>0.7900</td>
<td>0.0900</td>
<td>0.0500</td>
<td>1.6449</td>
</tr>
<tr>
<td>0.95064</td>
<td>200</td>
<td>0.7000</td>
<td>0.8000</td>
<td>0.1000</td>
<td>0.0500</td>
<td>1.6449</td>
</tr>
</tbody>
</table>

* Power was computed using the normal approximation method.

### Chart Section

Power ranges from 0.08859 for a true proportion of 0.71 to 0.95064 for a true proportion of 0.80.
**Example 8 – Finding the Power using Ratios**

Suppose that only 5% of patients with an aggressive type of cancer respond to the standard treatment. Designers have found a new treatment which could be widely used if the percentage of patients responding is at least 0.5 times greater than the proportion responding to the standard treatment, i.e., $P_1 = 1.5(P_0)$, or in terms of ratios, $P_1/P_0 = 1.5$. What power will be achieved for trials with sample sizes of 200, 300, 500, or 800 and a significance level of 0.05? For comparative purposes, also calculate the power for alternative ratios of 1.25 and 1.75.

**Setup**

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the **Tests for One Proportion** procedure window by expanding Proportions, then One Proportion, then Test (Inequality), and then clicking on Tests for One Proportion. You may then make the appropriate entries as listed below, or open Example 8 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Power</td>
</tr>
<tr>
<td>Power Calculation Method</td>
<td>Binomial Enumeration</td>
</tr>
<tr>
<td>Max n for Binomial Enumeration</td>
<td>10000</td>
</tr>
<tr>
<td>Alternative Hypothesis</td>
<td>Two-Sided</td>
</tr>
<tr>
<td>Test Type</td>
<td>Exact Test</td>
</tr>
<tr>
<td>N (Population Size)</td>
<td>Infinite</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>n (Sample Size)</td>
<td>200 300 500 800</td>
</tr>
<tr>
<td>Input Type</td>
<td>Ratios</td>
</tr>
<tr>
<td>P0 (Null Proportion)</td>
<td>0.05</td>
</tr>
<tr>
<td>P1 (Alternative Proportion)</td>
<td>1.25 1.50 1.75</td>
</tr>
</tbody>
</table>

**Output**

Click the Calculate button to perform the calculations and generate the following output.

**Numeric Results**

<table>
<thead>
<tr>
<th>Power*</th>
<th>n</th>
<th>P0</th>
<th>P1</th>
<th>P1-P0</th>
<th>Target Alpha</th>
<th>Actual Alpha*</th>
<th>Reject H0 if R ≤</th>
<th>R ≥</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.12473</td>
<td>200</td>
<td>0.0500</td>
<td>0.0625</td>
<td>1.2500</td>
<td>0.0500</td>
<td>0.0328</td>
<td>3</td>
<td>17</td>
</tr>
<tr>
<td>0.33215</td>
<td>200</td>
<td>0.0500</td>
<td>0.0750</td>
<td>1.5000</td>
<td>0.0500</td>
<td>0.0328</td>
<td>3</td>
<td>17</td>
</tr>
<tr>
<td>0.58605</td>
<td>200</td>
<td>0.0500</td>
<td>0.0875</td>
<td>1.7500</td>
<td>0.0500</td>
<td>0.0328</td>
<td>3</td>
<td>17</td>
</tr>
<tr>
<td>0.13148</td>
<td>300</td>
<td>0.0500</td>
<td>0.0625</td>
<td>1.2500</td>
<td>0.0500</td>
<td>0.0328</td>
<td>7</td>
<td>24</td>
</tr>
<tr>
<td>0.40189</td>
<td>300</td>
<td>0.0500</td>
<td>0.0750</td>
<td>1.5000</td>
<td>0.0500</td>
<td>0.0328</td>
<td>7</td>
<td>24</td>
</tr>
<tr>
<td>0.70620</td>
<td>300</td>
<td>0.0500</td>
<td>0.0875</td>
<td>1.7500</td>
<td>0.0500</td>
<td>0.0328</td>
<td>7</td>
<td>24</td>
</tr>
<tr>
<td>0.21380</td>
<td>500</td>
<td>0.0500</td>
<td>0.0625</td>
<td>1.2500</td>
<td>0.0500</td>
<td>0.0395</td>
<td>15</td>
<td>36</td>
</tr>
<tr>
<td>0.62478</td>
<td>500</td>
<td>0.0500</td>
<td>0.0750</td>
<td>1.5000</td>
<td>0.0500</td>
<td>0.0395</td>
<td>15</td>
<td>36</td>
</tr>
<tr>
<td>0.90715</td>
<td>500</td>
<td>0.0500</td>
<td>0.0875</td>
<td>1.7500</td>
<td>0.0500</td>
<td>0.0395</td>
<td>15</td>
<td>36</td>
</tr>
<tr>
<td>0.35086</td>
<td>800</td>
<td>0.0500</td>
<td>0.0625</td>
<td>1.2500</td>
<td>0.0500</td>
<td>0.0420</td>
<td>27</td>
<td>53</td>
</tr>
<tr>
<td>0.84317</td>
<td>800</td>
<td>0.0500</td>
<td>0.0750</td>
<td>1.5000</td>
<td>0.0500</td>
<td>0.0420</td>
<td>27</td>
<td>53</td>
</tr>
<tr>
<td>0.98822</td>
<td>800</td>
<td>0.0500</td>
<td>0.0875</td>
<td>1.7500</td>
<td>0.0500</td>
<td>0.0420</td>
<td>27</td>
<td>53</td>
</tr>
</tbody>
</table>

* Power and actual alpha were computed using binomial enumeration of all possible outcomes.
This report shows the values of each of the parameters, one scenario per row. Because of the discrete nature of the binomial distribution, the stated (Target) alpha is usually greater than the actual alpha. Hence, we also show the Actual Alpha along with the rejection region. The values from this table are plotted in the chart below.

**Charts Section**

These plots show the relationship between power and P1/P0 in this example. We note that 80% power is achieved with a sample size of about 720 when P1/P0 is 1.50, which was the specific ratio of interest.
Example 9 – Validation of Sample Size Calculation for the Z-Test with S(P0) using Ryan (2013)

Ryan (2013) page 106 gives the results of a sample size calculation for a one-sided Z-test with S(P0). When $P_0 = 0.50$, $P_1 = 0.6$, power $= 0.8$, and alpha $= 0.05$, Ryan (2013) reports a required sample size of 153.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Tests for One Proportion procedure window by expanding Proportions, then One Proportion, then Test (Inequality), and then clicking on Tests for One Proportion. You may then make the appropriate entries as listed below, or open Example 9 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td>Sample Size</td>
</tr>
<tr>
<td>Solve For</td>
<td>Sample Size</td>
</tr>
<tr>
<td>Power Calculation Method</td>
<td>Normal Approximation</td>
</tr>
<tr>
<td>Alternative Hypothesis</td>
<td>One-Sided</td>
</tr>
<tr>
<td>Test Type</td>
<td>Z-test using S(P0)</td>
</tr>
<tr>
<td>Power</td>
<td>0.8</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>Input Type</td>
<td>Proportions</td>
</tr>
<tr>
<td>P0 (Null Proportion)</td>
<td>0.50</td>
</tr>
<tr>
<td>P1 (Alternative Proportion)</td>
<td>0.6</td>
</tr>
</tbody>
</table>

Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

PASS calculated the same sample size of 153 as Ryan (2013).

Fleiss, Levin, and Paik (2003) page 34 gives the results of an effect size calculation for a one-sided Z-test using S(P0) with Continuity Correction. When n = 100, P0 = 0.06, power = 0.9, and alpha = 0.05, Fleiss, Levin, and Paik (2003) reports that the detectable value for P1 is less than 0.01.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Tests for One Proportion procedure window by expanding Proportions, then One Proportion, then Test (Inequality), and then clicking on Tests for One Proportion. You may then make the appropriate entries as listed below, or open Example 10 by going to the File menu and choosing Open Example Template.

Option Value
Design Tab
Solve For Sample Size
Power Calculation Method Normal Approximation
Alternative Hypothesis One-Sided
Test Type Z-test using S(P0) with C.C.
Power 0.90
Alpha 0.05
n (Sample Size) 100
Input Type Proportions
P0 (Null Proportion) 0.06
P1 (Alternative Proportion) Search < P0

Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th>Power*</th>
<th>n</th>
<th>Proportion Given H0</th>
<th>Proportion Given H1</th>
<th>Difference P1-P0</th>
<th>Alpha</th>
<th>Reject H0 If Z &lt;</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.90000</td>
<td>100</td>
<td>0.0600</td>
<td>0.0060</td>
<td>-0.0540</td>
<td>0.0500</td>
<td>-1.6449</td>
</tr>
</tbody>
</table>

* Power was computed using the normal approximation method.

PASS calculated the detectable P1 to be 0.006, which is less than 0.01 as reported by Fleiss, Levin, and Paik (2003).
Example 11 – Validation of Sample Size Calculation for the Z-Test with S(Phat) using Chow, Shao, and Wang (2008)

Chow, Shao, and Wang (2008) page 87 gives the results of a sample size calculation for a two-sided Z-test with S(Phat). When P0 = 0.30, P1 = 0.5, power = 0.8, and alpha = 0.05, Chow, Shao, and Wang (2008) reports a required sample size of 49.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Tests for One Proportion procedure window by expanding Proportions, then One Proportion, then Test (Inequality), and then clicking on Tests for One Proportion. You may then make the appropriate entries as listed below, or open Example 11 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Sample Size</td>
</tr>
<tr>
<td>Power Calculation Method</td>
<td>Normal Approximation</td>
</tr>
<tr>
<td>Alternative Hypothesis</td>
<td>Two-Sided</td>
</tr>
<tr>
<td>Test Type</td>
<td>Z-test using S(Phat)</td>
</tr>
<tr>
<td>Power</td>
<td>0.80</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>Input Type</td>
<td>Proportions</td>
</tr>
<tr>
<td>P0 (Null Proportion)</td>
<td>0.30</td>
</tr>
<tr>
<td>P1 (Alternative Proportion)</td>
<td>0.50</td>
</tr>
</tbody>
</table>

Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th>Power*</th>
<th>n</th>
<th>Proportion Given H0 P0</th>
<th>Proportion Given H1 P1</th>
<th>Difference P1-P0</th>
<th>Alpha</th>
<th>Reject H0 If</th>
<th>Z</th>
<th>&gt;</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.80743</td>
<td>50</td>
<td>0.3000</td>
<td>0.5000</td>
<td>0.2000</td>
<td>0.050</td>
<td>1.9600</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* Power was computed using the normal approximation method.

PASS calculates the same sample size to be 50, one higher than reported in Chow, Shao, and Wang (2008). The difference is due to rounding. PASS uses full precision but the book uses rounded values. If you calculate the power for n=49, you’ll see that the actual power is 0.79956, which is slightly less than the required 0.8.
Example 12 – Validation of Binomial Enumeration Power Calculation for the Exact Test using Zar (2010)

Zar (2010) page 539 gives the results of a power analysis for a one-sided binomial exact test. When $n = 12$, $P_0 = 0.50$, $P_1 = 0.833$, and alpha = 0.05, Zar (2010) reports a power of 0.68.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Tests for One Proportion procedure window by expanding Proportions, then One Proportion, then Test (Inequality), and then clicking on Tests for One Proportion. You may then make the appropriate entries as listed below, or open Example 12 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td>Power</td>
</tr>
<tr>
<td>Solve For</td>
<td>Power</td>
</tr>
<tr>
<td>Power Calculation Method</td>
<td>Binomial Enumeration</td>
</tr>
<tr>
<td>Max n for Binomial Enumeration</td>
<td>10000</td>
</tr>
<tr>
<td>Alternative Hypothesis</td>
<td>One-Sided</td>
</tr>
<tr>
<td>Test Type</td>
<td>Exact Test</td>
</tr>
<tr>
<td>N (Population Size)</td>
<td>Infinite</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>n (Sample Size)</td>
<td>12</td>
</tr>
<tr>
<td>Input Type</td>
<td>Proportions</td>
</tr>
<tr>
<td>P0 (Null Proportion)</td>
<td>0.50</td>
</tr>
<tr>
<td>P1 (Alternative Proportion)</td>
<td>0.833</td>
</tr>
</tbody>
</table>

Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

PASS calculated the power to be 0.67624, which agrees with the Zar (2010) value of 0.68.
Example 13 – Validation of Approximate Power Calculation for Exact Test using Zar (2010)

Zar (2010) page 541 gives the results of a power analysis for a two-sided binomial exact test. When \( n = 50, \ P_0 = 0.50, \ P_1 = 0.4 \) (the book has a typo and states this to be 0.5, but uses 0.4 in calculations), and \( \alpha = 0.05 \), Zar (2010) reports a power of 0.29.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the **Tests for One Proportion** procedure window by expanding **Proportions**, then **One Proportion**, then **Test (Inequality)**, and then clicking on **Tests for One Proportion**. You may then make the appropriate entries as listed below, or open **Example 13** by going to the **File** menu and choosing **Open Example Template**.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Design Tab</strong></td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Power</td>
</tr>
<tr>
<td>Power Calculation Method</td>
<td>Normal Approximation</td>
</tr>
<tr>
<td>Alternative Hypothesis</td>
<td>Two-Sided</td>
</tr>
<tr>
<td>Test Type</td>
<td>Exact Test</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>( n ) (Sample Size)</td>
<td>50</td>
</tr>
<tr>
<td>Input Type</td>
<td>Proportions</td>
</tr>
<tr>
<td>( P_0 ) (Null Proportion)</td>
<td>0.5</td>
</tr>
<tr>
<td>( P_1 ) (Alternative Proportion)</td>
<td>0.4</td>
</tr>
</tbody>
</table>

Output

Click the Calculate button to perform the calculations and generate the following output.

**Numeric Results**

| Proportion Given \( H_0 \) | Proportion Given \( H_1 \) | Difference \( P_1-P_0 \) | \( \alpha \) | Reject \( H_0 \) if \( |R| \geq \) |
|-----------------------------|-----------------------------|--------------------------|-------------|-----------------|
| 0.5000                      | 0.4000                      | -0.1000                  | 0.0500      | 17/33           |

* Power was computed using the normal approximation method.

PASS calculated the power to be 0.28905, which agrees with the Zar (2010) value of 0.29.